International Innovation In Artificial Intelligence Artificial Intelligence Applications Institute 

Four decades of world-leading research and teaching in AI at Edinburgh
Two decades of innovative applications of AI at AIAI

Examples of key achievements include: 

· Formation - a knowledge-based design system to lay out all British Telecom Yellow Pages directories and to create a new business area for Pindar Set Ltd for responsive marketing support and catalogue layout systems. Winner of an award for innovative applications of AI in 1998. 

· Expert Provisioner - a rule-based system for the RAF Logistics to assist with procurement of spare parts. Saves £30m per annum for the RAF and is now being deployed to the British Army and Navy. 

· EASE – a rule-based system deployed throughout Europe to estimate occupational exposure to hazardous substances for health and safety regulations. 

· Fraud Detection – case-based reasoning has been applied to screen applications for financial products with MCL Software. 

· GhostWriter - plan generation and multilingual presentation for aero-engine maintenance procedures with British Aerospace and Dassault Aviation (France). 

· O-Plan and I-X - command, planning and control agents to support non-combatant evacuation operations, US Army military operations in urban terrain, multinational coalition operations, disaster relief, search & rescue, etc. 

· Optimum-AIV - planning system for assembly, integration and test of Ariane IV payloads for the European Space Agency. 

· EUMETSAT - specification of the telecommand system for the European Meteorological Spacecraft Control Centre. 

· International Standards - inputs to the development of standards for process specification, workflow, enterprise modelling, etc. 

Artificial Intelligence Applications Institute
Centre for Intelligent Systems and their Applications
School of Informatics, The University of Edinburgh
Appleton Tower, Crichton Street, Edinburgh EH8 9LE, UK
Tel: +44 131 650 2732; Fax: +44 131 650 6513                                                                         E-mail: aiai@ed.ac.uk
www.aiai.ed.ac.uk
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The next generation of knowledge lifecycle technologies

Description:

#Multi-million pound 6 year collaboration
between 6 university groups:
#Aberdeen: cooperative KA & knowledge refinement;
+Edinburgh: lfecycles & ontologies;

+Open Uni: internetbhrsed services & knowledge
modelling components;

+Sheffiekl: textanalyss & infonmation extraction;
+Southampton: togrows withskils in multinedia,
ontologies, agents, knowledge acqusition, etc.

#Aims to identify or invent the next generation
of technologies for capture, modelling,
publishing, reuse and management of
knowledge.
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KRAFT-IX Ontology based Collaboration support
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IF-Map Architecture

Results:

#IF-Map: uses Information Flow theory to
merge two ontologies, based on a reference
ontology.

#FLife life-cycle editor, life-cycle interpreter
and property checker: uses a formal life cycle
calculus to describe property alterations
during transformations.

#ExtrAKT Ontology Constraint Extraction Tool:
finds ontology constraints in existing
declarative knowledge bases & extracts them.

KRAFT-IX Collaborative Support tool:
integrates open-architecture workflow system
with remote constraint solving system

Universities of Aberdeen, Edinburgh, Sheffield, Southampton & OU
Funded by EPSRC as an Interdisciplinary Research Collaboration

ot http://www.aiai.ed.ac.uk/project/akt/

Further work:

#The ultimate goal of F-Life is to permit
assembly of distributed software components
over the Semantic Web, to perform complex
transformations on lar ge repositories of
knowledge.

#The aim of KRAFT-IX is to provide a
distributed virtual knowledge-based (and
agent-based) workflow system.

#The overall aim of AKT s to provide seamless,
intelligent, personalised access to and
reasoning across the Web and other
knowledge sources.

i

The ExtrAKT Ontology Constraint Extraction Tool
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Collaborative Advanced Knowledge Technologies in the Grid
’ Further work:

¢ BuddySpace: Automatic maps, personal
profiles, matchmaking services, zones of trust.

Description:

¢ Support e-Science collaboration by integrating
tools for & demonstrating utility of:

¢ |-X: Enrich exchange of concepts between I-X
and Compendium and links between |I-Space
and BuddySpace to develop a ‘meeting
ontology’.

esintelligent task-orientated messaging,
collaborative planning, issue, activity and
constraint management;

eperipheral awareness of the online presence,
availability, attributes and location of
colleagues, documents, & devices;

¢ Deal with issues supporting temporal, dynamic,
and distributed resources

ereal time conversational mapping of ¢ Symbiosis with other ontologies and project.

meetings, providing shared visual focus and

group memory capture ; ¢ Inform meeting mark-up and personal presence

using Smart Spaces (personal knowledge

emultimedia meeting mark-up, replay & devices, etc.).

navigation.

Goals and technologies: T

I-XI<I-N-C-A> ¢ To integrate multiple modes of collaboration.

Process Panels &
Intelligent ¢ To enable replay of recorded and asynchronous |~

Messaging meetings, navigated using process and issue-
based ontologies.

¢ BuddySpace Instant Messenger (KMi/OU).

¢ Compendium for real time conversation
mapping (KMi/OU). e e R
asynchronous activit
¢ |-X Process Panels/<I-N-C-A> for Task-oriented . 5 :
messaging, planning and management (AlAl,
Edinburgh).

: e & HyStream for multimedia mark-up
HyStream: meeting BuddySpace: awareness of presence  (JAM/Southampton).
annotation and replay Compendium: mapping of meetings

AlAl, Open University and University of Southampton B _.:
cience ntn:/iwww.aiai.ed.ac.uk/project/coakting/ l"’
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Description:

¢ Students in the Department of Business
Studies at the University of Edinburgh have
wide flexibility in their course choices

Technical approach:

¢ Knowledge acquired from one interview and
from the University Calendar.

. ¢ Knowledge analysed and system designed
+but timetable clashes rule out some using KADS methodology.

courses
. . ¢ System implemented using CLIPS, “stripped
sand Department regulations require some down” for delivery on student lab PCs.

outside courses to be taken for 2 or 3 years. A
. & Used ‘negative truth maintenance’ - course Y

was marked as vnavailable due to clash with
course X, unless course Xwas deselected.

¢ Directors of Studies used to spend 15-20
minutes explaining this to each of 50-60

students.
- & Entire project took 8 man weeks.

¢ Course Selector is a knowledge based system
that advises on legal course combinations and
sensible course choices.

& Success due to good methodology and
structure-preserving design. o

Benefits:

¢ Students no longer needed to navigate
through the 800-page University Calendar.

¢ Automatically found timetable clashes
(including one between two required courses
for a joint degree).

¢ Directors of Studies now spent 5 minutes per
student in the first week of the academic year
instead of 15-20 minutes.

¢ Students can keep a disk of course choices
from previous years to reduce the input
required in later years.

Model showing control & interactions

AlAl and the University of Edinburgh Management School - _. ©
http://lwww.aiai.ed.ac.uk/project/courseselector/ —y =l: '
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Estimation of substance exposure for new industrial processes

Technical approach:

< Initial prototype developed by UK Health &
Safety Laboratories.

Description:

¢ A knowledge based system to support
occupational hygienists
¢ AlAl and HSL staff collaborated in developing

oWhen a new industrial process is
new system:

developed,occupational hygienists must
assess how toxic the substance is and how

¢ HSL staff trained in Al techniques.
likely workers are to be exposed to it.

¢Used the CommonKADS methodology for
modelling knowledge.

¢Used CLIPS and wxCLIPS (AlAl product)
for software.

¢ EASE supports the latter task.
¢ Key factors include:

¢ Pattern of control: e.g. closed system.

& Success through technology transfer and
knowledge modelling.

oWhether a closed system is ever breached
e.g. for cleaning.

L Estimation and Assessment of Substance Exposure (EASE)

Benefits: Fle_View window Hob
¢ Highlights potentially dangerous situations T EASE Information
Eile  Help
that may be negIeCted° The process may be carried out under full containment, but the closed
. . 1 y be breached if work ired to tak |
# Easier method of enforcing health & safety of he product rem the system for inspection or the system may be.
idali d10 enable therl mrme——
gu Ide IInes' :ﬂ;::a t;eer:i:o :he :: Explanation
. model WItItI| c:’:;:i“uet:o Inhalation exposure to the gas, vapour of ﬁqun:l aerosol of tri-alcohol
o Easier to update than paper manuals. conainmentis notapr L DTS ae
. level of control appliec :::m:;z:ﬁgﬁmmml
¢ Has been taken up by regulatory agencies . SewionLog and the abilty o the substance to become aibore (moderate igh)
around Europe. 'k resulting in an exposure range of 70-100 ppm

1
ICONCLUSION: The predictec

CommonKADS “model schema” EASE Interface

Acknowledgement for photograph: http://www.southwalesinfocus.com/

AlAl and the Health & Safety Laboratory

HEAITH & SAFETY http://www.aiai.ed.ac.uk/project/ease/ —
LABORATORY 4
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A framework for enterprise modelling & integration

Description:

¢ Major UK initiative to promote use of
knowledge based systems in enterprise
modelling.

¢ Enterprise Toolset developed to support
¢Capturing aspects of a business;

¢Planning of user tasks based on
procedures;

¢ Execution of process models;
<¢Integration of off-the-shelf tools;

¢ Standardised representation &
communication.

& 1.1 : Project portfolio analysis
Card Edit Navigate

I
|

JS[=] B3

Znalyse Hodify
proposals

Enact project
portfolio plans

Generate
propesals

The Enterprise Procedure Builder

Technical Capability (Entity)| Cognitive Capability Business Capability (Entity)

»Analysis (Device) »Understanding »Marketing
*Requirements Analysis »Reasoning *Customer Liaison
*Hazard Analysis »Creativity »Commercial
*Quality Analysis »Knowledge *Contracts
*Testability Analysis »Authoring (Document) *Bidding

» Testing »Management (Device) *Commissioning

»Review »Development (Device) ®Procurement

» Assessment Physical Capability (Entity) »Personnel

»Modelling »Manual Capability »Financial

»Engineering *Repair

>Design *Removal

»>Integration *Fitting

»Maintenance sConnecting

>Use *Replacement

IT-Capability »Sensory Capability
»Database Capability (Data) »Project Capability (Project)
*Storage *Management
*Structured Storage »Planning
*Hierarchical Storage »Organising
*Relational Storage »Controlling
*Unstructured Storage »Communication (Entity)
*Retrieval *Request
*Search *Respond
*Calculation *Inform
*Simulation »Co-operation (Entity)
Results:
esSuits.

¢ Procedure Builder for capturing process
models.

¢ Task Manager for integration, visualisation,
and support for process enactment.

¢ Agent Toolkit to support development of
agents in an agent-based architecture to
support integration of COTS tools.

¢ Enterprise Ontology for standardised
representation & communication.

¢ Bid Manager demonstrator developed jointly
with Pilkington Optronics.

du AlAl, Logica, IBM UK, Lloyds Register and Unilever

i

Funded by the DTI Intelligent Systems Integration Programme
http://lwww.aiai.ed.ac.uk/project/enterprise/

Further work:

¢ Lloyds Register uses the Enterprise toolset
for more effective modelling and re-
engineering of business processes for
strategic planning.

¢ Unilever used the toolset within its R&D
activities.

¢I|BM UK used the Enterprise ontology in
modelling its own internal organisation.

¢ The conceptual approach was carried
forward into the Task-Based Process
Management research project.

i Enterprise Task Manager O] x|
File Edit View Tools Advice Help
Session Tasks
Project Portfolio Analysis
reactivate data
find data file
read data file Tasks shown
analyse project data All _:_J
calculate portfolio ratings
reactivate portfolio ratings
find portfolio ratings Aspects shown
read portfolio ratings Task state
store project data Agert selected
stare portfolio ratings Hierarchy role
generate scenario Motes
| running task input project data
Notes on selected task with agent Project Description Tool and inputs .
Hit OK for successful run, Cancel for unsuccessful run.
=
‘ 1 running
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Accurate prediction and ordel of aircraft parts
Description: Technical approach:
#A knowledge-based provisioning support M ] | eRAF Logistics Support personnel trained in Al
system. techniques.
#Removes mundane form processing and #lntelligent provisioning used as a worked
prevents misinterpretation of special codes. 4 S| example.
. . X eManagement interest led to development of
#Brings together information formerly stored Y
on nger?orms and index cards. v 4 prototype using CLIPS rule-based system.
ePrompts user to investigate where necessary. eSenior management interest in prototype led

to development of full system.
’Dw?l“’j'(;’v'::ggg" distributed on networked #Visual Basic and MS Access used.

@ Success through using the simplest
technology adequate for the task.

Benefits: [ b
#Reduces the uncertainty of procurement =

budgets near financial year-ends. i
#Reduces wastage through over-ordering. s —
#Takes advantage of price breaks for large o o

orders. e
#Maintains consistency of order processing. — = 1
#Easy to use and to understand.
#Estimated savings of £30 million per year.

Dl
Original erder form Order form in Expert Provisioner

..&"  AlAland RAF Logistics Support Services
E/! http://www.aiai.ed.ac.uk/projects/ep/
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Knowledge-Based Layout of BT Yellow Pages

Description:

¢ A knowledge-based system for laying out
Yellow Pages.

¢ Must include text entries, fixed size
advertisements, headings etc.

¢ Allows programming of document styles.

¢ Allows dialogue-based modification and
reconfiguration of programmed styles.

¢ Automatically lays out telephone directory
according to style.

& Formation

Technical approach:

¢ Layout styles are defined in a purpose-built
Lonng object-oriented language, implemented in

N
2000/200;

Lisp.

¢ Allows definition of page geometry, page
items, layout strategy, and modular

& ek heuristics.
Gy

THE gy i
BSuessGetd, ¢ Can be used by non-programmers.

¢ Pindar staff worked alongside AIAI during
language development to obtain full working
knowledge of the language.

& Success through flexibility, usability &
technology transfer.

Benefits:

¢ Originally commissioned by Pindar Set to
complete the contract to produce the UK
Yellow Pages.

¢ Lays out directories at over 1500 pages/hour.

¢ Fast and flexible response to change
requests.

¢ Small reduction in wasted space brings large
cost savings.

¢ Generic and customisable, allowing
production of a variety of Yellow Pages styles.

AlAl and Pindar Set

http://lwww.aiai.ed.ac.uk/project/formation/ ——y—
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Plan based generation of mul

Description:

#An authoring environment to support #Maintenance procedures are written using
production of technical documents by British aplan-based knowledge representation.
Aerospace and Dassault Aviation. #Planning technology validates these

#Each aircraft has a large number of . procedures.
maintenance & other documents, required in : #Documents are then generated from this

9 - = language-neutral representation.

#GhostWriter supports generation of technical . o
dommentation o e language. #Procedures can be displayed using simple

graphics.

It also gives advice about possible errors and . "
omissions during the consiruction of a #Success through improved productivity
publication. and increased error checking.

AN

| Benefits:

#Prototype has been used to produce
documents for most of a complex
maintenance procedure for the Falcon 900.

#The resulting texts are at a level close to that
produced by human authors.

eCurrent version is interactive and semi-
automatic.

m ¥
& eltalso offers a potential speed-up in
document authoring.
ATornado aircraft with its
accompa technical documentation

The internal representation used by GhostWriter

British Aerospace, Dassault Aviation, & University of Edinburgh o _. ®
http://www.aiai.ed.ac.uk/project/ghostwriter/ — ) '
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Intelligent Messaging, Event and Process Panels ‘

= Further work:
eintelligent Planning Aid (“I-Plan”).

Description:

eCan take on and handle issues, activities,
constraints, and annotations/reports in the

#“On-the-fly” repair and recovery during
G2 process.

planning, execution and control of Coalition

elntelligent messaging support. =/ C?processes.

| #Group collaboration facilities; links to other
| collaboration & video-teleconferencing aids.

- eImproved process library editor.

. " E elmproved “I-Space” agent relationship
#Operates anywhere in continuum from = management tool and links to Grid

manual to fully automatic. Management Services.

eintelligent workflow and process support.

#Uses a simple <I-N-C-A> ontology
issues, Nodes/Activities, Constraints, Annotations.

#Part of CoAX - Coalition Agents Experiment. DARPA CoAX Demo elmproved deployment.
e S e Results: OrPMeme OTolMemBe
#Process Panels used for each command or Issues Panel ‘ (CToolMemBa
country in CoAX demonstration. U
ool Paske
#Flexible and loadable process models, it Paet 1
process product descriptions and issue
descriptions.
elnter-agent commands, reports and message G S oo
logging. Produt Statu Pasel el MemuBr
connster g Clarification of who says what to who else.
et E eLinks to external capabilities. Logo Pasel B
= Lspane T | I
I-X Process Panel Interfaces Schematic of I-X Process Panel Components

AIAI e @
@ Funded by the DARPA CoABS & DAML initiatives _—ﬁ_: —— '
http://i-x.info

aAnan
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Planning for Spacecraft Assembly, Integration & Test
Technical approach:

Description:

#A knowledge-based system for planning and *A r_e_smlrce-driven §(_:he(_1||lin(_| n_|eclmnisn|
scheduling of spacecraft assembly, integration » T facilitates the specification of different
and verification (AIV). scenarios.

#Aims to overcome simplified planning which QScl_ledllle develapm_enl can be lymnilared
manages temporal constraints but not & while alternately using automatic mode/
resources or parallel activities. manual mode.

#Commercial planning tools are either too p e ¥ #Notes conflicting demands for resources that
simple to represent problems correctly or too z » cannot be solved automatically and supports

- the user in solving them.

complex to be used interactively.
#Allows monitoring of plan execution.

@ Success through involving & supporting the
user in difficult decisions.

#Used for planning the production of the vehicle
equipment bays (VEB) for the Ariane-4
launcher.

¥ Benefits:

#Rich description of AIV constraints is
provided touser and used by the tool.

#Supports user in resolving resource conflicts.

#Clear representation & interactive capability
allows assessment of several planning
scenarios.

#Provides a single solution to both schedule

equipment modules amongst competing
VEBS.

AlAI, Computer Resources Intl, Matra Marconi Space & Progespace
Funded by the European Space Agency
http://www.aiai.ed.ac.uk/project/optimum-aiv/
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Intelligent planning & task support for search and rescue

 Technical approach:

¢ RAF Search and Rescue: O-Plan style
planning based on CommonKADS model.

Description:

¢ Knowledge-based tools for RAF Search and
Rescue
e¢Linked to multiple user interfaces.

¢ CoSAR-TS: Shared intelligible models

eotasks, structures, agents, capabilities, ...

¢Selecting plans.
¢Generating “To Do” lists.

¢Automating status information.

+CoSAR-TS to share plans and processes ¢ |-X Process Panels for activity management.

between collaborating software agents in a
Search and Rescue scenario

& Success through providing task support to
human decision makers.

¢Uses DAML ontologies to support
matching of resources to needs.

Benefits:
¢ RAF Search & Rescue was capable of

¢Automating administrative tasks.

¢Planning efficient use of helicopters & crew.

¢ Used to provide specification for fully
developed system.

¢ CoSAR-TS

¢Enables cooperation between software and
human agents.

¢Links models of coalition organizational
. . structures, policies, and doctrines with
CoSAR-TS “downed airman” scenario intelligent task support software.

RAF SAR: AlAl, DRA, Royal Air Force
CoSAR-TS: AlAl, IHMC, BBN Technologies
http://www.aiai.ed.ac.uk/project/cosar-ts/
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Knowledge-based interpretation of oil well tests

Technical approach:

¢ A pattern matcher matches (pre-processed)
test data with theoretical models to compute
model parameters.

Description:

¢ Oil well tests require selecting an appropriate
model to describe this particular oil well.

¢ This is difficult because: ¢ A belief network uses the non-numerical
terms of a world expert to describe
uncertainty, and reasons with uncertain data.

e¢lt requires data from engineers,
geologists, geophysicists & petrophysicists;
¢There is considerable uncertainty in data; ¢ Several external data interfaces were

#Different models sometimes produce the provided to aid interdisciplinary dialogue.

same response. ¢ First developed using KEE and Hardy; final

¢ SPIRIT recommends the most appropriate prototype used CLOS and XView.

model to use.

& Success through reasoning with uncertainty
& supporting multiple experts

Model Display Window

Benefits:

¢ Semi-automation of pattern recognition in
pressure data.

¢ Potential uses as a training tool and to carry
out well test design calculations.

s
s \
,

¢ Reduced the non-uniqueness problem. - o f'/;gjj (0
fracture IBC . . ‘M — » e .‘_
¢ Knowledge-based decision support. s 1 ‘,% ‘,\T\*‘“"'}Z‘_?,i N
T . . . ‘ gm‘ ”\Zi Mo TS
¢ Integrates geological and engineering e é,}'&‘\“ fapeld
‘. information with pressure data. S\, :
\ /.
NG

Data Input Windows

Belief network

mmmmm
G0

Data interface: geological structure

Acknowledgement for image of drilling rig in South China Sea: www.middlebury.edu

AlAl, Petroleum Science & Technology Institute (now ITF),
Enterprise Oil, Shell UK, Amoco, Bow Valley, Elf-Enterprise.
http://www.aiai.ed.ac.uk/project/spirit/
































